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CHAPTER
ONE

INTRODUCTION

The 0penM°de"cq system described in this document has both short-term and long-term goals:

The short-term goal is to develop an efficient interactive computational environment for the Modelica lan-
guage, as well as a rather complete implementation of the language. It turns out that with support of
appropriate tools and libraries, Modelica is very well suited as a computational language for development
and execution of both low level and high level numerical algorithms, e.g. for control system design, solving
nonlinear equation systems, or to develop optimization algorithms that are applied to complex applications.

The long-term goal is to have a complete reference implementation of the Modelica language, including
simulation of equation based models and additional facilities in the programming environment, as well
as convenient facilities for research and experimentation in language design or other research activities.
However, our goal is not to reach the level of performance and quality provided by current commercial
Modelica environments that can handle large models requiring advanced analysis and optimization by the
Modelica compiler.

The long-term research related goals and issues of the OpenModelica open source implementation of a Modelica
environment include but are not limited to the following:

Development of a complete formal specification of Modelica, including both static and dynamic semantics.
Such a specification can be used to assist current and future Modelica implementers by providing a semantic
reference, as a kind of reference implementation.

Language design, e.g. to further extend the scope of the language, e.g. for use in diagnosis, structural
analysis, system identification, etc., as well as modeling problems that require extensions such as partial
differential equations, enlarged scope for discrete modeling and simulation, etc.

Language design to improve abstract properties such as expressiveness, orthogonality, declarativity, reuse,
configurability, architectural properties, etc.

Improved implementation techniques, e.g. to enhance the performance of compiled Modelica code by gen-
erating code for parallel hardware.

Improved debugging support for equation based languages such as Modelica, to make them even easier to
use.

Easy-to-use specialized high-level (graphical) user interfaces for certain application domains.
Visualization and animation techniques for interpretation and presentation of results.

Application usage and model library development by researchers in various application areas.

The OpenModelica environment provides a test bench for language design ideas that, if successful, can be submit-
ted to the Modelica Association for consideration regarding possible inclusion in the official Modelica standard.

The current version of the OpenModelica environment allows most of the expression, algorithm, and function
parts of Modelica to be executed interactively, as well as equation models and Modelica functions to be compiled
into efficient C code. The generated C code is combined with a library of utility functions, a run-time library, and
a numerical DAE solver.
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1.1 System Overview

The OpenModelica environment consists of several interconnected subsystems, as depicted in Figure 1.1.

MDT Eclipse Plugir

Editor/Browser

GraphicalModel
Editor/Browser

3
OMODfi Interactive t
ptim sessionhandler
Optimization —— Mo-gee)l(téglitor
Subsystem
OMNotebook _
DrModelica Execution Model_lca
Model Editor Compiler
Modelica
Debugger

Figure 1.1: The architecture of the OpenModelica environment. Arrows denote data and control flow. The inter-
active session handler receives commands and shows results from evaluating commands and expressions that are
translated and executed. Several subsystems provide different forms of browsing and textual editing of Modelica
code. The debugger currently provides debugging of an extended algorithmic subset of Modelica.

The following subsystems are currently integrated in the OpenModelica environment:

* An interactive session handler, that parses and interprets commands and Modelica expressions for evalua-
tion, simulation, plotting, etc. The session handler also contains simple history facilities, and completion of
file names and certain identifiers in commands.

A Modelica compiler subsystem, translating Modelica to C code, with a symbol table containing definitions
of classes, functions, and variables. Such definitions can be predefined, user-defined, or obtained from
libraries. The compiler also includes a Modelica interpreter for interactive usage and constant expression
evaluation. The subsystem also includes facilities for building simulation executables linked with selected
numerical ODE or DAE solvers.

An execution and run-time module. This module currently executes compiled binary code from translated
expressions and functions, as well as simulation code from equation based models, linked with numerical
solvers. In the near future event handling facilities will be included for the discrete and hybrid parts of the
Modelica language.

Eclipse plugin editor/browser. The Eclipse plugin called MDT (Modelica Development Tooling) provides
file and class hierarchy browsing and text editing capabilities, rather analogous to previously described
Emacs editor/browser. Some syntax highlighting facilities are also included. The Eclipse framework has
the advantage of making it easier to add future extensions such as refactoring and cross referencing support.

OMNotebook DrModelica model editor. This subsystem provides a lightweight notebook editor, compared
to the more advanced Mathematica notebooks available in MathModelica. This basic functionality still
allows essentially the whole DrModelica tutorial to be handled. Hierarchical text documents with chapters
and sections can be represented and edited, including basic formatting. Cells can contain ordinary text
or Modelica models and expressions, which can be evaluated and simulated. However, no mathematical
typesetting facilities are yet available in the cells of this notebook editor.

Graphical model editor/browser OMEdit. This is a graphical connection editor, for component based model
design by connecting instances of Modelica classes, and browsing Modelica model libraries for reading and
picking component models. The graphical model editor also includes a textual editor for editing model class
definitions, and a window for interactive Modelica command evaluation.

Chapter 1. Introduction
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* Optimization subsystem OMOptim. This is an optimization subsystem for OpenModelica, currently for
design optimization choosing an optimal set of design parameters for a model. The current version has a
graphical user interface, provides genetic optimization algorithms and Pareto front optimization, works in-
tegrated with the simulators and automatically accesses variables and design parameters from the Modelica
model.

* Dynamic Optimization subsystem. This is dynamic optimization using collocation methods, for Model-
ica models extended with optimization specifications with goal functions and additional constraints. This
subsystem is integrated with in the OpenModelica compiler.

* Modelica equation model debugger. The equation model debugger shows the location of an error in the
model equation source code. It keeps track of the symbolic transformations done by the compiler on the
way from equations to low-level generated C code, and also explains which transformations have been done.

* Modelica algorithmic code debugger. The algorithmic code Modelica debugger provides debugging for an
extended algorithmic subset of Modelica, excluding equation-based models and some other features, but in-
cluding some meta-programming and model transformation extensions to Modelica. This is a conventional
full-feature debugger, using Eclipse for displaying the source code during stepping, setting breakpoints, etc.
Various back-trace and inspection commands are available. The debugger also includes a data-view browser
for browsing hierarchical data such as tree- or list structures in extended Modelica.

1.2 Interactive Session with Examples

The following is an interactive session using the interactive session handler in the OpenModelica environment,
called OMShell — the OpenModelica Shell. Most of these examples are also available in the OMNotebook with
DrModelica and DrControl UsersGuideExamples.onb as well as the testmodels in:

>>> getInstallationDirectoryPath() + "/share/doc/omc/testmodels/"
"«OPENMODELICAHOME»/share/doc/omc/testmodels/"

The following commands were run using OpenModelica version:

>>> getVersion ()
"OMCompiler v1.21.0-dev.28+g7e9048385a"

1.2.1 Starting the Interactive Session

Under Windows, go to the Start Menu and run OpenModelica->OpenModelica Shell which responds with an
interaction window.

Under Linux, run OMShell-terminal to start the interactive session at the prompt.

We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored in
the variable x. The value of the expression is returned.

>>> x 1= 1:12
{1,2,3,4,5,6,7,8,9,10,11,12}

1.2.2 Using the Interactive Mode

When running OMC in interactive mode (for instance using OMShell) one can make load classes and execute
commands. Here we give a few example sessions.

1.2. Interactive Session with Examples 5
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Example Session 1

>>> model A Integer t = 1.5; end A; //The type is Integer but 1.5 is of Real Type
{A}

>>> instantiateModel (&)

nmn

"[<interactive>:1:9-1:23:writable] Error: Type mismatch in binding t = 1.5
—expected subtype of Integer, got type Real.

n

[

Example Session 2

If you do not see the error-message when running the example, use the command getErrorString ().

model C
Integer a;
Real b;
equation
der(a) = b; // der(a) is illegal since a 1is not a Real number
der (b) 12.0;
end C;

>>> instantiateModel (C)
nn

Error:

[<interactive>:5:3-5:13:writable] Error: Argument ‘CAST(Real, a)‘ of der is not differentiable.

1.2.3 Trying the Bubblesort Function

Load the function bubblesort, either by using the pull-down menu File->Load Model, or by explicitly giving the
command:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—bubblesort.mo")
true

The function bubblesort is called below to sort the vector x in descending order. The sorted result is returned to-
gether with its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is the declared
type of the function result. The input Integer vector was automatically converted to a Real vector according to
the Modelica type coercion rules. The function is automatically compiled when called if this has not been done
before.

>>> bubblesort (x)
{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0}

Another call:

>>> bubblesort ({4,6,2,5,8})
{8.0,6.0,5.0,4.0,2.0}

6 Chapter 1. Introduction
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1.2.4 Trying the system and cd Commands

It is also possible to give operating system commands via the system utility function. A command is provided as
a string argument. The example below shows the system utility applied to the UNIX command cat, which here
outputs the contents of the file bubblesort.mo to the output stream when running omc from the command-line.

>>> gystem("cat '"+getInstallationDirectoryPath()+"/share/doc/omc/testmodels/
—bubblesort.mo' > bubblesort.mo")
0

function bubblesort

input Real[:] x;

output Real[size(x,1)] y;
protected

Real t;
algorithm

Yy T X

for i in l:size(x,1l) loop

for j in 1l:size(x,1) loop
if y[i] > yI[J] then

t o= ylil;
y[i] = y[31;
yI[3l = t;
end if;
end for;
end for;

end bubblesort;

Note: The output emitted into stdout by system commands is put into log-files when running the CORBA-based
clients, not into the visible GUI windows. Thus the text emitted by the above cat command would not be returned,
which is why it is redirected to another file.

A better way to read the content of files would be the readFile command:

>>> readFile ("bubblesort.mo")
function bubblesort

input Real[:] x;

output Real[size(x,1)] vy;
protected

Real t;
algorithm

y 1= X

for i in 1l:size(x,1) loop

for j in 1l:size(x,1) loop
if y[i] > y[Jj] then

t o= ylil;
yl[il = y[3];
yI[3l = t;
end if;
end for;
end for;

end bubblesort;

The system command only returns a success code (0 = success).

>>> sgystem("dir")

0

>>> system("Non-existing command")
127

Another built-in command is cd, the change current directory command. The resulting current directory is returned
as a string.
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>>> dir:=cd ()

"«DOCHOME»"

>>> cd("source")

"«DOCHOME»/source"

>>> cd(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/")
"/var/lib/jenkinsl/ws/OpenModelica_PR-7477_2/build/share/doc/omc/testmodels"
>>> cd(dir)

"«DOCHOME»"

1.2.5 Modelica Library and DCMotor Model

We load a model, here the whole Modelica standard library, which also can be done through the File->Load
Modelica Library menu item:

>>> loadModel (Modelica, {"3.2.3"})
true

We also load a file containing the decmotor model:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/dcmotor.mo
<y ")

true

Note:

Notification: demotor requested package Modelica of version 3.2.2. Modelica 3.2.3 is used instead which states
that it is fully compatible without conversion script needed.

It is simulated:

>>> gimulate (dcmotor, startTime=0.0, stopTime=10.0)
record SimulationResult

resultFile = "«DOCHOME»/dcmotor_ res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'dcmotor', options = '', |
—outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.276024538,

timeBackend = 0.014174799,
timeSimCode = 0.003850307,
timeTemplates = 0.003687789,

timeCompile = 0.751143512,
timeSimulation = 0.020042076,
timeTotal = 1.069070357

end SimulationResult;

Note:

Notification: demotor requested package Modelica of version 3.2.2. Modelica 3.2.3 is used instead which states
that it is fully compatible without conversion script needed.

‘We list the source code of the model:

>>> list (dcmotor)
model dcmotor

(continues on next page)

8 Chapter 1. Introduction




OpenModelica User’s Guide, Release v1.21.0-dev-28-gc03b332154

(continued from previous page)

import Modelica.Electrical.Analog.Basic;

Basic.Resistor resistorl (R = 10);

Basic.Inductor inductorl(L = 0.2, i.fixed = true);

Basic.Ground groundl;

Modelica.Mechanics.Rotational.Components.Inertia load(J = 1, phi.fixed = true, w.
—~fixed = true);

Basic.EMF emfl(k = 1.0);

Modelica.Blocks.Sources.Step stepl;

Modelica.Electrical.Analog.Sources.SignalVoltage signalVoltagel;

equation

connect (stepl.y, signalVoltagel.v);
connect (signalVoltagel.p, resistorl.p);
connect (resistorl.n, inductorl.p);
connect (inductorl.n, emfl.p);
connect (emfl.flange, load.flange_a);
connect (signalVoltagel.n, groundl.p);
connect (groundl.p, emfl.n);
annotation (

uses (Modelica (version = "3.2.2")));

end dcmotor;

‘We test code instantiation of the model to flat code:

>>> instantiateModel (dcmotor)
class dcmotor

parameter Real resistorl.R(quantity = "Resistance", unit = "Ohm", start = 1.0) =
—10.0 "Resistance at temperature T_ref";

parameter Real resistorl.T_ref (quantity = "ThermodynamicTemperature", unit = "K",
— displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = 300.15
—"Reference temperature";

parameter Real resistorl.alpha(quantity = "LinearTemperatureCoefficient", unit =
—"1/K") = 0.0 "Temperature coefficient of resistance (R_actual = Rx (1 + alphax (T_
—heatPort - T_ref))";

Real resistorl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of |
—the two pins (= p.v - n.v)";

Real resistorl.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from_
—pin p to pin n";

Real resistorl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real resistorl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing
—into the pin";

Real resistorl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real resistorl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing,
—into the pin";

final parameter Boolean resistorl.useHeatPort = false "=true, if heatPort is_
—~enabled";

parameter Real resistorl.T(quantity = "ThermodynamicTemperature", unit = "K",
—~displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = resistorl.T_
—ref "Fixed device temperature if useHeatPort = false";

Real resistorl.LossPower (quantity = "Power", unit = "W") "Loss power leaving,
—component via heatPort";

Real resistorl.T_heatPort (quantity = "ThermodynamicTemperature", unit = "K", |
—displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) "Temperature
—~of heatPort";

Real resistorl.R_actual (quantity = "Resistance", unit = "Ohm") "Actual_
—resistance = Rx (1l + alphax (T_heatPort - T_ref))";

Real inductorl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of_
—the two pins (= p.v - n.v)";

Real inductorl.i(quantity = "ElectricCurrent", unit = "A", start = 0.0, fixed =

—true) "Current flowing from pin p to pin n";

(continues on next page)
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(continued from previous page)

Real inductorl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real inductorl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing_
—into the pin";

Real inductorl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real inductorl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing
—into the pin";

parameter Real inductorl.L(quantity = "Inductance", unit = "H", start = 1.0) = 0.
—2 "Inductance";

Real groundl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real groundl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into,
—the pin";

Real load.flange_a.phi (quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real load.flange_a.tau(gquantity = "Torque", unit = "N.m") "Cut torque in the_
—flange";

Real load.flange_b.phi(quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real load.flange_b.tau(quantity = "Torque", unit = "N.m") "Cut torque in the_
—flange";

parameter Real load.J(quantity = "MomentOfInertia", unit = "kg.m2", min = 0.0,
—start = 1.0) = 1.0 "Moment of inertia";

final parameter enumeration (never, avoid, default, prefer, always) load.
—stateSelect = StateSelect.default "Priority to use phi and w as states";

Real load.phi(quantity = "Angle", unit = "rad", displayUnit = "deg", fixed =
—true, stateSelect = StateSelect.default) "Absolute rotation angle of component";

Real load.w(quantity = "AngularVelocity", unit = "rad/s", fixed = true,
—stateSelect = StateSelect.default) "Absolute angular velocity of component (=
—der (phi))";

Real load.a(quantity = "AngularAcceleration", unit = "rad/s2") "Absolute angular,
—acceleration of component (= der(w))";

final parameter Boolean emfl.useSupport = false "= true, if support flange_
—enabled, otherwise implicitly grounded";

parameter Real emfl.k(quantity = "ElectricalTorqueConstant", unit = "N.m/A",
—~start = 1.0) = 1.0 "Transformation coefficient";

Real emfl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop between_
—the two pins";

Real emfl.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from,
—positive to negative pin";

Real emfl.phi (quantity = "Angle", unit = "rad", displayUnit = "deg") "Angle of |
—shaft flange with respect to support (= flange.phi - support.phi)";

Real emfl.w(quantity = "AngularVelocity", unit = "rad/s") "Angular velocity of
—flange relative to support";

Real emfl.tau(quantity = "Torque", unit = "N.m") "Torque of flange";

Real emfl.tauElectrical (quantity = "Torque", unit = "N.m") "Electrical torque";

Real emfl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";

Real emfl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into
—the pin";

Real emfl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";

Real emfl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into
—the pin";

Real emfl.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real emfl.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange
=";

protected parameter Real emfl.fixed.phiO (quantity = "Angle", unit = "rad",_
—displayUnit = "deg") = 0.0 "Fixed offset angle of housing";

protected Real emfl.fixed.flange.phi (quantity = "Angle", unit = "rad",
—displayUnit = "deg") "Absolute rotation angle of flange";

(continues on next page)
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protected Real emfl.fixed.flange.tau(quantity = "Torque", unit = "N.m") "Cut_
—torque in the flange";

protected Real emfl.internalSupport.tau(quantity = "Torque", unit = "N.m") = -
—emfl.tau "External support torque (must be computed via torque balance in model_
—where InternalSupport is used; = flange.tau)";

protected Real emfl.internalSupport.phi(quantity = "Angle", unit = "rad",
—displayUnit = "deg") "External support angle (= flange.phi)";

protected Real emfl.internalSupport.flange.phi (quantity = "Angle", unit = "rad",
—displayUnit = "deg") "Absolute rotation angle of flange";

protected Real emfl.internalSupport.flange.tau(quantity = "Torque", unit = "N.m
—") "Cut torque in the flange";

parameter Real stepl.height = 1.0 "Height of step";
Real stepl.y "Connector of Real output signal";
parameter Real stepl.offset = 0.0 "Offset of output signal y";

parameter Real stepl.startTime (quantity = "Time", unit = "s") = 0.0 "Output y =,
—~offset for time < startTime";

Real signalVoltagel.p.v(quantity = "ElectricPotential", unit = "V") "Potential,
—at the pin";

Real signalVoltagel.p.i(quantity = "ElectricCurrent"”, unit = "A") "Current,_

—flowing into the pin";

Real signalVoltagel.n.v(quantity = "ElectricPotential", unit = "V") "Potential
—at the pin";

Real signalVoltagel.n.i(quantity = "ElectricCurrent"”, unit = "A") "Current
—~flowing into the pin";

Real signalVoltagel.v(unit = "V") "Voltage between pin p and n (= p.v — n.v) as,
—input signal";

Real signalVoltagel.i(quantity = "ElectricCurrent", unit = "A") "Current flowing_

—from pin p to pin n";
equation
emfl.internalSupport.flange.phi = emfl.fixed.flange.phi;
stepl.y = signalVoltagel.v;
signalVoltagel.p.v = resistorl.p.v;
resistorl.n.v = inductorl.p.v;
inductorl.n.v = emfl.p.v;
emfl.flange.phi = load.flange_a.phi;
groundl.p.v = emfl.n.v;
groundl.p.v = signalVoltagel.n.v;
inductorl.p.i + resistorl.n.i = 0.0;
emfl.p.i + inductorl.n.i = 0.0;
load.flange_b.tau = 0.0;
emfl.flange.tau + load.flange_a.tau = 0.0;
emfl.internalSupport.flange.tau + emfl.fixed.flange.tau = 0.0;
signalVoltagel.p.1i + resistorl.p.i = 0.0;
signalVoltagel.n.i + emfl.n.i + groundl.p.i = 0.0;
assert (1.0 + resistorl.alpha * (resistorl.T_heatPort - resistorl.T_ref) >= le-15,
— "Temperature outside scope of model!");
resistorl.R_actual = resistorl.R % (1.0 + resistorl.alpha * (resistorl.T_
—heatPort - resistorl.T_ref));
resistorl.v = resistorl.R_actual *» resistorl.i;
resistorl.LossPower = resistorl.v * resistorl.i;
resistorl.T_heatPort = resistorl.T;
resistorl.v = resistorl.p.v - resistorl.n.v;
0.0 = resistorl.p.i + resistorl.n.i;
resistorl.i = resistorl.p.i;
inductorl.L % der (inductorl.i) = inductorl.v;
inductorl.v = inductorl.p.v - inductorl.n.v;
0.0 = inductorl.p.i + inductorl.n.i;
inductorl.i = inductorl.p.i;
groundl.p.v = 0.0;
load.phi = load.flange_a.phi;
load.phi = load.flange_b.phi;

(continues on next page)
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load.w = der(load.phi);

load.a = der(load.w);

load.J % load.a = load.flange_a.tau + load.flange_b.tau;
emfl.fixed.flange.phi = emfl.fixed.phiO;
emfl.internalSupport.flange.tau = emfl.internalSupport.tau;
emfl.internalSupport.flange.phi = emfl.internalSupport.phi;
emfl.v = emfl.p.v — emfl.n.v;

0.0 = emfl.p.i + emfl.n.i;

emfl.i = emfl.p.1i;

emfl.phi = emfl.flange.phi - emfl.internalSupport.phi;
emfl.w = der (emfl.phi);

emfl.k » emfl.w = emfl.v;
emfl.tau = -emfl.k » emfl.i;
emfl.tauElectrical = -emfl.tau;

emfl.tau = emfl.flange.tau;
stepl.y = stepl.offset + (if time < stepl.startTime then 0.0 else stepl.height);
signalVoltagel.v = signalVoltagel.p.v - signalVoltagel.n.v;
0.0 = signalvVoltagel.p.i + signalVoltagel.n.i;
signalVoltagel.i = signalVoltagel.p.i;
end dcmotor;

Note:

Notification: dcmotor requested package Modelica of version 3.2.2. Modelica 3.2.3 is used instead which states
that it is fully compatible without conversion script needed.

We plot part of the simulated result:

T
load.w
load.phi

15 1

0.5 ]

Figure 1.2: Rotation and rotational velocity of the DC motor
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1.2.6 The val() function

The val(variableName,time) scription function can be used to retrieve the interpolated value of a simulation result
variable at a certain point in the simulation time, see usage in the BouncingBall simulation below.

1.2.7 BouncingBall and Switch Models

We load and simulate the BouncingBall example containing when-equations and if-expressions (the Modelica
keywords have been bold-faced by hand for better readability):

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")
true

>>> list (BouncingBall)
model BouncingBall
parameter Real e = 0.7 "coefficient of restitution";
parameter Real g = 9.81 "gravity acceleration";
Real h(fixed = true, start = 1) "height of ball";
Real v (fixed = true) "velocity of ball";
Boolean flying(fixed = true, start = true) "true, if ball is flying";
Boolean impact;
Real v_new(fixed = true);
Integer foo;
equation
impact = h <= 0.0;
foo = if impact then 1 else 2;
der (v) = if flying then -g else 0;
der (h) = v;
when {h <= 0.0 and v <= 0.0, impact} then
v_new = if edge (impact) then -expre(v) else 0;
flying = v_new > 0O;
reinit (v, v_new);
end when;
end BouncingBall;

Instead of just giving a simulate and plot command, we perform a runScript command on a .mos (Modelica script)
file sim_BouncingBall.mos that contains these commands:

>>> writeFile("sim_BouncingBall.mos", "

loadFile (getInstallationDirectoryPath() + \"/share/doc/omc/testmodels/
—BouncingBall.mo\");

simulate (BouncingBall, stopTime=3.0);

/* plot ({h, flying}); =/
")
true
>>> runScript ("sim_BouncingBall.mos")
"true
record SimulationResult

resultFile = \"«DOCHOME»/BouncingBall_res.mat\",

simulationOptions = \"startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'BouncingBall', options =
—''", outputFormat = 'mat', variableFilter = '.%', cflags = '', simflags = ''\",

messages = \"LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.
\"I

timeFrontend = 0.003360621,

timeBackend = 0.006310489000000001,

timeSimCode = 0.002013116,

timeTemplates = 0.06272034800000001,

(continues on next page)
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timeCompile = 0.659448338,
timeSimulation = 0.021493843,
timeTotal = 0.755471878

end SimulationResult;

"

model Switch
Real v;
Real i;
Real i1l;
Real itot;
Boolean open;
equation
itot = 1i + 1i1;
if open then
v = 0;
else
i = 0;
end if;
1 - 11 = 0;
1 - v -1 = 0;
open = time >= 0.5;
end Switch;

>>> simulate (Switch, startTime=0, stopTime=1)
record SimulationResult

resultFile = "«DOCHOME»/Switch_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'Switch', options = "',
—outputFormat = 'mat', variableFilter '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.004088506,

timeBackend = 0.01242085,
timeSimCode = 0.0021135,
timeTemplates = 0.006929828000000001,

timeCompile = 0.68175639,
timeSimulation = 0.018799056,
timeTotal = 0.726256851

end SimulationResult;

Retrieve the value of itot at time=0 using the val(variableName, time) function:

>>> val (itot, 0)
1.0

Plot itot and open:

We note that the variable open switches from false (0) to true (1), causing itot to increase from 1.0 to 2.0.
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itot
open
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Figure 1.3: Plot when the switch opens
1.2.8 Clear All Models
Now, first clear all loaded libraries and models:
>>> clear ()
true
List the loaded models — nothing left:
>>> list ()
nmnn
1.2.9 VanDerPol Model and Parametric Plot
We load another model, the VanDerPol model (or via the menu File->Load Model):
>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/VanDerPol.
—mo")
true
It is simulated:
>>> simulate (VanDerPol, stopTime=80)
record SimulationResult
resultFile = "«DOCHOME»/VanDerPol_res.mat",
simulationOptions = "startTime = 0.0, stopTime = 80.0, numberOfIntervals = 500,
— tolerance = le-06, method = 'dassl', fileNamePrefix = 'VanDerPol', options = "'
— outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",
messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
4

timeFrontend = 0.003908384,
timeBackend = 0.004248746,
timeSimCode .0012204009,
timeTemplates = 0.008203780000000001,
timeCompile = 0.7065686849999999,

0
0

(continues on next page)

1.2. Interactive Session with Examples 15




OpenModelica User’s Guide, Release v1.21.0-dev-28-gc03b332154

(continued from previous page)

timeSimulation = 0.026137164,
timeTotal = 0.750419398
end SimulationResult;

It is plotted:

>>> plotParametric("x","y")

2.5 T T T T T T T

2 b
15

1k
0.5

> 0+

-0.5
1k
-1.5

2+

_25 | | | | | | |

-2.5 -2 -1.5 -1 -0.5 0 0.5 1

Figure 1.4: VanDerPol plotParametric(x,y)

Perform code instantiation to flat form of the VanDerPol model:

>>> instantiateModel (VanDerPol)
class VanDerPol "Van der Pol oscillator model"
Real x(start = 1.0, fixed = true);

Real y(start = 1.0, fixed = true);
parameter Real lambda = 0.3;
equation
der (x) = y;
der(y) = (-x) + lambda * (1.0 — x % x) * y;

end VanDerPol;

1.2.10 Using Japanese or Chinese Characters

Japenese, Chinese, and other kinds of UniCode characters can be used within quoted (single quote) identifiers, see

for example the variable name to the right in the plot below:

16
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File Edit Special

Plot by OpenModelica
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1.2.11 Scripting with For-Loops, While-Loops, and If-Statements

A simple summing integer loop (using multi-line input without evaluation at each line into OMShell requires
copy-paste as one operation from another document):

>>> k := 0;

>>> for 1 in 1:1000 loop
k := k + 1i;

end for;

>>> k

500500

A nested loop summing reals and integers:

>>> g := 0.0;
>>> h := 5;
>>> for i in {23.0,77.12,88.23} loop
for j in 1i:0.5:(i+1l) loop
g =g+ 3J;
g := g+ h / 2;
end for;
h :=h + g;
end for;

By putting two (or more) variables or assignment statements separated by semicolon(s), ending with a variable,
one can observe more than one variable value:

>>> h; g
1997.45
1479.09

A for-loop with vector traversal and concatenation of string elements:

>>> j.="";
>>> 1lst := {"Here ", "are ","some ","strings."};
>>> g = "";

>>> for i in lst loop

(continues on next page)
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s := s + 1ij
end for;
>>> 5

"Here are some strings."

Normal while-loop with concatenation of 10 "abc " strings:

>>> g:="";
>>> i:=1;
>>> while i<=10 loop
s:="abc "+s;
i:=1i+1;
end while;
>>> 3
"abc abc abc abc abc abc abc abc abc abc "

A simple if-statement. By putting the variable last, after the semicolon, its value is returned after evaluation:

>>> if 5>2 then a := 77; end if; a
77

An if-then-else statement with elseif"

>>> if false then

a := 5;
elseif a > 50 then
b:= "test"; a:= 100;
else
a:=34;
end if;

Take a look at the variables a and b:

>>> a;b
100
"test"

1.2.12 Variables, Functions, and Types of Variables

Assign a vector to a variable:

>>> ga:=1:5
{1,2,3,4,5}

Type in a function:

function mySqr
input Real x;
output Real y;

algorithm
ViI=X*X;

end mySqr;

Call the function:

>>> b:i=mySqr (2)
4.0

Look at the value of variable a:
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>>> a
{1,2,3,4,5}

Look at the type of a:

>>> typeOf (a)
"Integer[5]"

Retrieve the type of b:

>>> typeOf (b)
"Real "

What is the type of mySqr? Cannot currently be handled.

>>> typeOf (mySqgr)

List the available variables:

>>> listVariables ()
{b,a,s,1lst,i,h,g,k,currentSimulationResult}

Clear again:

>>> clear ()
true

1.2.13 Getting Information about Error Cause

Call the function getErrorString() in order to get more information about the error cause after a simulation failure:

>>> getErrorString()

1.2.14 Alternative Simulation Output Formats

There are several output format possibilities, with mat being the default. plt and mat are the only formats that
allow you to use the val() or plot() functions after a simulation. Compared to the speed of plt, mat is roughly 5
times for small files, and scales better for larger files due to being a binary format. The csv format is roughly twice
as fast as plt on data-heavy simulations. The plt format allocates all output data in RAM during simulation, which
means that simulations may fail due applications only being able to address 4GB of memory on 32-bit platforms.
Empty does no output at all and should be by far the fastest. The csv and plt formats are suitable when using an
external scripts or tools like gnuplot to generate plots or process data. The mat format can be post-processed in
MATLAB or Octave.

>>> simulate (...
>>> simulate (...

(
(
(
(

outputFormat="mat")
outputFormat="csv")
outputFormat="plt")
outputFormat="empty")

>>> simulate (...
>>> simulate (...

~ S~ S~ 0~

It is also possible to specify which variables should be present in the result-file. This is done by using POSIX
Extended Regular Expressions. The given expression must match the full variable name (* and $ symbols are
automatically added to the given regular expression).

/l Default, match everything

>>> simulate (... , variableFilter=".x")
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/I match indices of variable myVar that only contain the numbers using combinations

/1 of the letters 1 through 3

’>>> simulate (... , variableFilter="myVar\\\[[1-3]7*\\\1")

// match x or y or z

’>>> simulate (... , variableFilter="x|y|z")

1.2.15 Using External Functions

See Chapter Interoperability — C and Python for more information about calling functions in other programming
languages.

1.2.16 Using Parallel Simulation via OpenMP Multi-Core Support

Faster simulations on multi-core computers can be obtained by using a new OpenModelica feature that auto-
matically partitions the system of equations and schedules the parts for execution on different cores using shared-
memory OpenMP based execution. The speedup obtained is dependent on the model structure, whether the system
of equations can be partitioned well. This version in the current OpenModelica release is an experimental ver-
sion without load balancing. The following command, not yet available from the OpenModelica GUI, will run a
parallel simulation on a model:

>>> omc —d=openmp model.mo

1.2.17 Loading Specific Library Version

There exist many different versiosn of Modelica libraries which are not compatible. It is possible to keep mul-
tiple versions of the same library stored in the directory given by calling getModelicaPath(). By calling load-
Model(Modelica,{"3.2"}), OpenModelica will search for a directory called "Modelica 3.2" or a file called "Mod-
elica 3.2.mo". Itis possible to give several library versions to search for, giving preference for a pre-release version
of a library if it is installed. If the searched version is "default", the priority is: no version name (Modelica), main
release version (Modelica 3.1), pre-release version (Modelica 3.1Beta 1) and unordered versions (Modelica Spe-
cial Release).

The loadModel command will also look at the uses annotation of the top-level class after it has been loaded. Given
the following package, Complex 1.0 and ModelicaServices 1.1 will also be loaded into the AST automatically.

package Modelica
annotation (uses (Complex (version="1.0"),
ModelicaServices (version="1.1")));

end Modelica;

>>> clear ()
true

Packages will also be loaded if a model has a uses-annotation:

model M
annotation (uses (Modelica (version="3.2.1")));
end M;

>>> instantiateModel (M)
class M
end M;
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Note:
Notification: Automatically loaded package Modelica 3.2.1 due to uses annotation from M.
Notification: Automatically loaded package Complex 3.2.1 due to uses annotation from Modelica.

Notification: Automatically loaded package ModelicaServices 3.2.1 due to uses annotation from Modelica.

Packages will also be loaded by looking at the first identifier in the path:

>>> instantiateModel (Modelica.Electrical.Analog.Basic.Ground)
class Modelica.Electrical.Analog.Basic.Ground "Ground node"

Real p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
Real p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin
=";
equation
p.i = 0.0;
p.v = 0.0;

end Modelica.Electrical.Analog.Basic.Ground;

Note:
Notification: Automatically loaded package Complex 4.0.0 due to uses annotation from Modelica.
Notification: Automatically loaded package ModelicaServices 4.0.0 due to uses annotation from Modelica.

Notification: Automatically loaded package Modelica default due to usage.

1.2.18 Calling the Model Query and Manipulation API

In the OpenModelica System Documentation, an external API (application programming interface) is described
which returns information about models and/or allows manipulation of models. Calls to these functions can be
done interactively as below, but more typically by program clients to the OpenModelica Compiler (OMC) server.
Current examples of such clients are the OpenModelica MDT Eclipse plugin, OMNotebook, the OMEdit graphic
model editor, etc. This API is untyped for performance reasons, i.e., no type checking and minimal error checking
is done on the calls. The results of a call is returned as a text string in Modelica syntax form, which the client has
to parse. An example parser in C++ is available in the OMNotebook source code, whereas another example parser
in Java is available in the MDT Eclipse plugin.

Below we show a few calls on the previously simulated BouncingBall model. The full documentation on this API
is available in the system documentation. First we load and list the model again to show its structure:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo");
>>> list (BouncingBall)
model BouncingBall
parameter Real e = 0.7 "coefficient of restitution";
parameter Real g = 9.81 "gravity acceleration";
Real h(fixed = true, start = 1) "height of ball";
Real v (fixed = true) "velocity of ball";
Boolean flying(fixed = true, start = true) "true, if ball is flying";
Boolean impact;
Real v_new(fixed = true);
Integer foo;

equation
impact = h <= 0.0;
foo = if impact then 1 else 2;
der(v) = if flying then -g else 0;
der (h) = v;

when {h <= 0.0 and v <= 0.0, impact} then

(continues on next page)
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(continued from previous page)

v_new = if edge(impact) then -expre(v) else 0;
flying = v_new > 0;
reinit (v, v_new);
end when;
end BouncingBall;

Different kinds of calls with returned results:

>>> getClassRestriction (BouncingBall)

"model"

>>> getClassInformation (BouncingBall)

("model","", false, false, false, "/var/lib/jenkinsl/ws/OpenModelica_PR-7477_2/build/

—share/doc/omc/testmodels/BouncingBall .mo", false,1,1,23,17,{},false, false,"","",
—false,"")

>>> isFunction (BouncingBall)

false

>>> existClass (BouncingBall)

true

>>> getComponents (BouncingBall)

{{Real, e, "coefficient of restitution", "public", false, false, false, false,
—"parameter", "none", "unspecified", {}},{Real, g, "gravity acceleration", "public
—", false, false, false, false, "parameter", "none", "unspecified", {}}, {Real, h,
—"height of ball", "public", false, false, false, false, "unspecified", "none",
—"unspecified", {}},{Real, v, "velocity of ball", "public", false, false, false,
—false, "unspecified", "none", "unspecified", {}},{Boolean, flying, "true, if |
—ball is flying", "public", false, false, false, false, "unspecified", "none",

—"unspecified", {}},{Boolean, impact, "", "public", false, false, false, false,
—"unspecified", "none", "unspecified", {}},{Real, v_new, "", "public", false,
—false, false, false, "unspecified", "none", "unspecified", {}},{Integer, foo, "",

— "public", false, false, false, false, "unspecified", "none", "unspecified", {}}}
>>> getConnectionCount (BouncingBall)

0

>>> getInheritanceCount (BouncingBall)

0

>>> getComponentModifierValue (BouncingBall,e)

llO.7ll

>>> getComponentModifierNames (BouncingBall, "e")

{}

>>> getClassRestriction (BouncingBall)

"model"

>>> getVersion() // Version of the currently running OMC
"OMCompiler v1.21.0-dev.28+g7e9048385a"

1.2.19 Quit OpenModelica

Leave and quit OpenModelica:

>>> quit ()
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1.2.20 Dump XML Representation

The command dumpXMLDAE dumps an XML representation of a model, according to several optional parame-
ters.

dumpXMLDAE(modelnamel ,asInSimulationCode=<Boolean>] [filePrefix=<String>] [,storeln-
Temp=<Boolean>] [,addMathMLCode =<Boolean>])

This command dumps the mathematical representation of a model using an XML representation, with optional
parameters. In particular, asInSimulationCode defines where to stop in the translation process (before dumping the
model), the other options are relative to the file storage: filePrefix for specifying a different name and storeInTemp
to use the temporary directory. The optional parameter addMathMLCode gives the possibility to don't print the
MathML code within the xml file, to make it more readable. Usage is trivial, just: addMathMLCode=true/false
(default value is false).

1.2.21 Dump Matlab Representation

The command export dumps an XML representation of a model, according to several optional parameters.
exportDAEtoMatlab(modelname);

This command dumps the mathematical representation of a model using a Matlab representation. Example:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")

true

>>> exportDAEtoMatlab (BouncingBall)

"The equation system was dumped to Matlab file:BouncingBall_imatrix.m"

% Adjacency Matrix

o)

% number of rows: 6

IM={{3,6},{1,{"if", "true','=='" {3}, {},}},{{"1f", 'true','==" {4},{},}}, {5}, {2, {"1if
—', 'edge (impact)"' {3}, {5},}},{4,2}};

VL = {'foo','v_new', "impact', 'flying','v', 'h'};

EgStr = {'impact = h <= 0.0;"',"'"foo = if impact then 1 else 2;','der(v) = if flying,
—then -g else 0.0;','der(h) = v;','when {h <= 0.0 and v <= 0.0, impact} then v_
—new = 1f edge (impact) then (-e) * pre(v) else 0.0; end when;', 'when {h <= 0.0,
—and v <= 0.0, impact} then flying = v_new > 0.0; end when;'};

OldEgStr={'class BouncingBall',' parameter Real e = 0.7 "coefficient of

—restitution";',' parameter Real g = 9.81 "gravity acceleration";',' Real
—h(start = 1.0, fixed = true) "height of ball";',' Real v (fixed = true)
—"velocity of ball";',' Boolean flying(start = true, fixed = true) "true, if
—ball is flying";',' Boolean impact;',' Real v_new(fixed = true);"',"' Integer,,
—~foo; ', 'equation', ' impact = h <= 0.0;"'," foo = if impact then 1 else 2;','
—der(v) = if flying then -g else 0.0;"'," der(h) = v;',"' when {h <= 0.0 and v <=_
—0.0, impact} then',' v_new = if edge (impact) then -e x pre(v) else 0.0;',"' .
—~flying = v_new > 0.0;"'," reinit (v, v_new);',' end when;','end BouncingBall; "',

=ty
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1.3 Summary of Commands for the Interactive Session Handler

The following is the complete list of commands currently available in the interactive session hander.

simulate(modelname) Translate a model named modelname and simulate it.

simulate(modelnamel startTime=<Real>][,stopTime=<Real>][,numberOflntervals
=<Integer>][,outputlnterval=<Real>][,method=<String>]
[,tolerance=<Real>][,fixedStepSize=<Real>]

[,outputFormat=<String>]) Translate and simulate a model, with optional start time, stop time, and optional
number of simulation intervals or steps for which the simulation results will be computed. More intervals will
give higher time resolution, but occupy more space and take longer to compute. The default number of intervals
is 500. It is possible to choose solving method, default is “dassl”, “euler” and “rungekutta” are also available.
Output format “mat” is default. “plt” and “mat” (MATLAB) are the only ones that work with the val() command,
“csv” (comma separated values) and “empty” (no output) are also available (see section Alternative Simulation
Output Formats).

plot(vars) Plot the variables given as a vector or a scalar, e.g. plot({x1,x2}) or plot(x1).

plotParametric(var!, var2) Plot var2 relative to varl from the most recently simulated model, e.g. plotParamet-
ric(x,y).

cd() Return the current directory.

cd(dir) Change directory to the directory given as string.

clear() Clear all loaded definitions.

clearVariables() Clear all defined variables.

dumpXMLDAE(modelname, ...) Dumps an XML representation of a model, according to several optional param-
eters.

exportDAEtoMatlab(name) Dumps a Matlab representation of a model.

instantiateModel(modelname)Performs code instantiation of a model/class and return a string containing the flat
class definition.

list() Return a string containing all loaded class definitions.
list(modelname) Return a string containing the class definition of the named class.
listVariables() Return a vector of the names of the currently defined variables.

loadModel(classname) Load model or package of name classname from the path indicated by the environment
variable OPENMODELICALIBRARY.

loadFile(str) Load Modelica file (.mo) with name given as string argument str.
readFile(str) Load file given as string str and return a string containing the file content.
runScript(str) Execute script file with file name given as string argument str.

system(str) Execute str as a system(shell) command in the operating system; return integer success value. Output
into stdout from a shell command is put into the console window.

timing(expr) Evaluate expression expr and return the number of seconds (elapsed time) the evaluation took.
typeOf(variable) Return the type of the variable as a string.

saveModel(str,modelname) Save the model/class with name modelname in the file given by the string argument
str.

val(variable,timePoint) Return the (interpolated) value of the variable at time timePoint.
help() Print this helptext (returned as a string).

quit() Leave and quit the OpenModelica environment
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1.4 Running the compiler from command line

The OpenModelica compiler can also be used from command line, in Windows cmd.exe or a Unix shell. The fol-
lowing examples assume omc is on the PATH; if it is not, you can run C: \OpenModelica 1.16.0\build\
bin\omc.exe or similar (depending on where you installed OpenModelica).

1.4.1 Example Session 1 — obtaining information about command line parame-
ters

$ omc —--help

OpenModelica Compiler OMCompiler v1.21.0-dev.28+g7e9048385a
Copyright © 2019 Open Source Modelica Consortium (OSMC)
Distributed under OMSC-PL and GPL, see www.openmodelica.org

Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]
« Libraries: Fully qualified names of libraries to load before processing Model or
—Script.

Documentation is available in the built-in package OpenModelica.Scripting or
online <https://build.openmodelica.org/Documentation/OpenModelica.Scripting.html>.

1.4.2 Example Session 2 — create an TestModel.mo file and run omc on it

model TestModel
parameter Real x = 1;
end TestModel;

S omc TestModel.mo

class TestModel
parameter Real x = 1.0;

end TestModel;

1.4.3 Example Session 3 — create a mos-script and run omc on it

loadModel (Modelica) ;

getErrorString();

simulate (Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum) ;
getErrorString();

$ omc TestScript.mos

false

"Error: Failed to open file for writing: //.openmodelica/libraries/index. json
Error: Failed to download package index https://libraries.openmodelica.org/index/
—vl/index.json to file //.openmodelica/libraries/index. json.

Error: Failed to open file for writing: //.openmodelica/libraries/index. json
Error: Failed to download package index https://libraries.openmodelica.org/index/
—vl/index.json to file //.openmodelica/libraries/index. json.

Error: Failed to load package Modelica (default) using MODELICAPATH //.
—openmodelica/libraries/.

n

record SimulationResult

resultFile = "",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOflIntervals = 500,
—~tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'Modelica.Mechanics.
—MultiBody.Examples.Elementary.Pendulum', options = '', outputFormat = 'mat',
—variableFilter = '.x', cflags = "', simflags = "'",

(continues on next page)
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(continued from previous page)

messages = "Simulation Failed. Model: Modelica.Mechanics.MultiBody.Examples.
—Elementary.Pendulum does not exist! Please load it first before simulation.",

timeFrontend = 0.0,

timeBackend = 0.0,

timeSimCode = 0.0,

timeTemplates = 0.0,

timeCompile = 0.0,

timeSimulation = 0.0,

timeTotal = 0.0
end SimulationResult;

nn

In order to obtain more information from the compiler one can use the command line options --
showErrorMessages -d=failtrace when running the compiler:

$ omc —--showErrorMessages —-d=failtrace TestScript.mos
InstFunction.getRecordConstructorFunction failed for OpenModelica.Scripting.
—loadModel

- Static.elabCrefSubs failed on: [top:<Prefix.NOPRE ()>].<Prefix.NOPRE ()>.Modelica_,
—env: <global scope>

— Static.elabCref failed: Modelica in env: <global scope>

- Static.elabCrefSubs failed on: [top:<Prefix.NOPRE ()>].<Prefix.NOPRE ()>.Modelica_,
—env: <global scope>

timeSimulation = 0.0,
timeTotal = 0.0

end SimulationResult;
nmnn
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CHAPTER
TWO

PACKAGE MANAGEMENT

2.1 Overview of Basic Modelica Package Management Concepts

The Modelica language promotes the orderly reuse of component models by means of packages that contain
structured libraries of reusable models. The most prominent example is the Modelica Standard Library (MSL),
that contains basic models covering many fields of engineering. Other libraries, both open-source and commercial,
are available to cover specific applications domains.

When you start a simulation project using Modelica, it is common practice to collect all related system models
in a project-specific package that you develop. The models in this package are often instantiated (e.g. by drag-
and-drop in OMEdit) from released libraries, which are read-only for your project. This establishes a dependency
between your project package and a certain version of a read-only package (or library), which is the one you have
loaded in OMEdit and that you drag-and-drop components from.

This dependency is automatically marked in your package by adding a uses annotation at the top level.
For example, if you drag and drop components from MSL 4.0.0 into models of your package, the
annotation (uses (Modelica (version="4.0.0"))); will be added automatically to it. This infor-
mation allows OpenModelica to automatically load all the libraries that are required to compile the models in your
own package next time you (or someone else, possibly on a different computer) loads your package, provided they
are installed in places on the computer's file system where OpenModelica can find them.

The default place where OpenModelica looks for packages is the so-called MODELICAPATH. You can check
where it is by typing getModelicaPath () in the Interactive Environment (Tools | OpenModelica Compiler
CLI in OMEdit). Installed read-only libraries are placed by default in the MODELICAPATH.

When a new version of certain package comes out, conversion annotations in it declare whether your models using
a certain older version of it can be used as they are with the new one, which is then 100% backwards-compatible,
or whether they need to be upgraded by running a conversion script, provided with the new version of the package.
The former case is declared explicitly by a conversion (noneFromVersion) annotation. For example, a
conversion (noneFromVersion="3.0.0") annotation in version 3.1 . 0 of a certain package means that
all packages using version 3.0.0 canuse 3. 1.0 without any change. Of course it is preferrable to use a newer,
backwards-compatible version, as it contains bugfixes and possibly new features.

Hence, if you install a new version of a library which is 100% backwards-compatible with the previous ones, all
your models that used the old one will automatically load and use the new one, without the need of any further
action.

If the new version is not backwards-compatible, instead, you will need to create a new version of your library that
uses it, by running the provided conversion scripts.

OpenModelica has a package manager that can be used to install and update libraries on your computer, and is
able to run conversion scripts. Keep in mind there are three stages in package usage: available packages are
indexed on the OSMC servers and can be downloaded from public repositories; installed packages are stored
in the MODELICAPATH of your computer; loaded packages are loaded in memory in an active OMC session,
either via the Interactive Environment, or via the OMEdit GUI, where they are shown in the Libraries Browser.
When you load a package, OpenModelica tries to load the best possible installed versions of all the dependencies
declared in the uses annotation.
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2.2 The Package Manager

The Open Source Modelica Consortium (OSMC) maintains a collection of publicly available, open-source Mod-
elica libraries on its servers, see https://github.com/OpenModelica/OMPackageManager. These libraries are rou-
tinely tested with past released versions of OpenModelica, as well as with the current development version on the
master branch, see the overview report. Based on the testing results and on information gathered from the library
developers, these packages are classified in terms of level of support in OpenModelica. Backwards-compatibility
information is also collected from the conversion annotations.

The OpenModelica Package Manager relies on this information to install the best versions of the library depen-
dencies of your own, locally developed Modelica packages and models. It can be run both from the OMEdit
GUI and from the command-line interactive environment. The libraries and their index. json index file with
all the library metadata are installed in the ~/.openmodelica/libraries directory under Linux and in
the $AppData%\.openmodelicallibraries directory on Windows. Note that these directories are user-
specific, so if there are multiple users on the same computer, each of them will install and manage his/her own set
of libraries independently from the others.

The Package Manager may install multiple builds of the same library version in your own package manager
directory, if they are indexed on the OSMC servers. When this happens, they are distinguished among each other
by means of semver-style pre- or post-release metadata in the top directory name on the file system. Post-release
builds are denoted by a plus sign (e.g. 2.0.0+build. 02) and have higher priority over the corresponding plain
release (e.g. 2.0.0), while pre-release builds are denoted by a minus sign (e.g. 2.0.0-dev.30) and have a
lower priority.

When loading a certain version of a library, unless a specific build is explicitly referenced, the one with
higher precedence will always be loaded. For example, if the versions 2.0.0-beta.01, 2.0.0, and 2.
0.0+build.01 are installed, the latter is loaded by libraries with uses annotation requiring version 2.0 . Q.
Unless, of course, there are later backwards-compatible versions installed, e.g., 2. 0.1, in which case the one
with the highest release number and priority is installed.

In any case, semver version semantics is only used to order the releases, while backwards-compatibility is deter-
mined exclusively on the basis of noneFromVersion annotations.

When installing OpenModelica, a cached version of the latest versions of the Modelica Standard Library is in-
cluded in the installation files. As soon as a user starts any OpenModelica tool (e.g., OMEdit, OMNotebook,
OMShell, or direct command-line invocation of omc), if the user's .openmodelica directory is empty the
Modelica Standard Library will be installed automatically using this cached version. This happens when using
OpenModelica for the first time, or if the contents of the . openmodelica directory have been deleted to get rid
of all installed libraries. This automatic installation needs no Internet connection, so it also works behind firewalls
or in set-ups with limited available bandwidth. Therefore, the Modelica Standard Library is immediately available
without the need of using the package manager explicitly. It is then possible to install and manage other libraries
using the package manager, as explained previously.

2.2.1 Package Management in OMEdit

Installing a new library in OMEdit.

2.2.2 Running Conversion Scripts in OMEdit

Converting a library in OMEdit.
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2.2.3 Automatically Loaded Packages in OMEdit

When you start OMEdit, some packages can be automatically loaded into the environment, and shown in the
Libraries Browser. You can configure which ones are loaded from the ToolslOptions|Libraries menu.

Please note that automatically loaded libraries may be in conflict with the dependencies of packages that you may
later load from the File menu. For example, if you automatically load Modelica 4.0 . 0, and then load a library
XYZ that still uses MSL 3. 2. 3, you get a conflict, because Modelica 4 . 0 . 0 is not backwards-compatible with
Modelica 3. 2. 3, so XYZ cannot be used.

In this case you have two options:

¢ Cancel Operation: this means XYZ is not actually loaded, and all previously loaded libraries remain in
place.

* Unload all and Reload XYZ: in this case, all previously loaded libraries, that may generate conflicts, are
unloaded first; then XYZ is loaded, and finally the right versions of the libraries XYZ uses, as declared in
its uses annotation, will be loaded automatically.

If you are normally working with only one version of the Modelica standard library, you can set it to be automati-
cally loaded from the ToolslOptionsl|Libraries menu; in case you need to work with a library that uses a previous,
non-backwards compatible version, the Unload all and Reload option comes handy. Otherwise, you can avoid
loading the Modelica library automatically upon starting OMEdit, and let the right version of the Modelica li-
brary be loaded automatically when you open the library you want to work with. In this case, if you want to get
the Modelica library into the Package Browser to start developing a new library, you can do so easily from the
Welcome tab, by clicking on the System Libraries button and selecting the version that you want to load.

2.2.4 Manually Loading Packages

If you want to maintain full control over which library dependencies are loaded, you can use the File | Open
Model/Library Files(s) menu command in OMEdit to open the libraries one by one from specific locations in your
file system. Note, however, that whenever a library is loaded, its dependencies, that are declared in its uses
annotation, will automatically be loaded. If you want to avoid that, you need to load the library dependencies in
reverse order, so that the intended library dependencies are already loaded when you open the library that needs
them.

If you are using the Interactive Environment, you can use the loadFile () command to load libraries from
specific locations on the file system, also in reverse dependency order, unless you also set the optional uses =
false input argument to disable the automatic loading of dependencies.

2.2.5 Using the Package Manager from the Interactive Environment

The Package Manager can also be used from the Interactive Environment command line shell. Here is a list
of examples of relevant commands; please type them followed by getErrorString(), e.g., updatePackagelndex();
getErrorString(), in order to get additional information, notifications and error messages.

updatePackagelndex() - this command puts the Package Manager in contact with the OSMC servers and
updates the internally stored list of available packages;

getAvailablePackageVersions(Building, "") - lists all available versions of the Buildings library on the
OSMC server, starting from the most recent one, in descending order of priority. Note that pre-release
versions have lower priority than all other versions;

getAvailablePackageVersions(Building, "7.0.0") - lists all available versions of the Buildings library on the
OSMC server that are backwards-compatible with version 7. 0. 0, in descending order of priority;

installPackage(Buildings, "") - install the most recent version of the Building libraries, and all its depen-
dencies;

installPackage(Buildings, "7.0.0") - install the most recent version of the Building libraries which is
backwards-compatible with version 7. 0. 0, and all its dependencies;

installPackage(Buildings, "7.0.0", exactMatch = true) - install version 7.0 . 0 even if there are more recent
backwards-compatible versions available, and all its dependencies;
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e upgradelnstalledPackages(installNewestVersions = true) - installs the latest available version of all installed
packages.

2.3 How the package index works

The package index is generated by OMPackageManager on an OSMC server, based on these settings. See its
documentation to see how to add new packages to the index, change support level, and so on.

The index is generated by scanning git repositories on github. All tags and optionally some specific branches are
scanned. The tag name is parsed as if it was a semantic version, with prerelease and metadata of the tag added to
the version of Modelica packages in the repository. If the tag name is not a semantic version, it is sorted differently.

Packages are sorted as follows:
» Support level: each package is given a level of support in the index

» Semantic version: according to the semver specification, but build metadata is also considered (sorted the
same way as pre-releases)

* Non-semantic versions: alphabetically
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CHAPTER
THREE

OMEDIT — OPENMODELICA CONNECTION EDITOR

OMEdit — OpenModelica Connection Editor is the new Graphical User Interface for graphical model editing in
OpenModelica. It is implemented in C++ using the Qt graphical user interface library and supports the Modelica
Standard Library that is included in the latest OpenModelica installation. This chapter gives a brief introduction
to OMEdit and also demonstrates how to create a DCMotor model using the editor.

OMEdit provides several user friendly features for creating, browsing, editing, and simulating models:
* Modeling — Easy model creation for Modelica models.
* Pre-defined models — Browsing the Modelica Standard library to access the provided models.
 User defined models — Users can create their own models for immediate usage and later reuse.

* Component interfaces — Smart connection editing for drawing and editing connections between model in-
terfaces.

* Simulation — Subsystem for running simulations and specifying simulation parameters start and stop time,
etc.

* Plotting — Interface to plot variables from simulated models.

3.1 Starting OMEdit

A splash screen similar to the one shown in Figure 3.1 will appear indicating that it is starting OMEdit. The
executable is found in different places depending on the platform (see below).

3.1.1 Microsoft Windows
OMEdit can be launched wusing the executable placed in OpenModelicalnstallationDirec-

tory/bin/OMEdit/OMEdit.exe. Alternately, choose OpenModelica > OpenModelica Connection Editor from the
start menu in Windows.

3.1.2 Linux

Start OMEdit by either selecting the corresponding menu application item or typing “OMEdit” at the shell or
command prompt.
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OMEdit

—
. L L
{

Figure 3.1: OMEdit Splash Screen.

3.1.3 Mac OS X

The default installation is /Application/MacPorts/OMEdit.app.

3.2 MainWindow & Browsers

The MainWindow contains several dockable browsers,
e Libraries Browser
¢ Documentation Browser
* Variables Browser
* Messages Browser
Figure 10.2 shows the MainWindow and browsers.

The default location of the browsers are shown in Figure 10.2. All browsers except for Message Browser can
be docked into left or right column. The Messages Browser can be docked into top or bottom areas. If you
want OMEdit to remember the new docked position of the browsers then you must enable Preserve User's GUI
Customizations option, see section General.
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Figure 3.2: OMEdit MainWindow and Browsers.
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3.2.1 Filter Classes

To filter a class click Edit > Filter Classes or press keyboard shortcut Ctrl+Shift+F. The loaded Modelica classes
can be filtered by typing any part of the class name.

3.2.2 Libraries Browser

To view the Libraries Browser click View > Windows > Libraries Browser. Shows the list of loaded Modelica
classes. Each item of the Libraries Browser has right click menu for easy manipulation and usage of the class. The
classes are shown in a tree structure with name and icon. The protected classes are not shown by default. If you
want to see the protected classes then you must enable the Show Protected Classes option, see section General.

3.2.3 Documentation Browser

Displays the HTML documentation of Modelica classes. It contains the navigation buttons for moving forward
and backward. It also contains a WYSIWYG editor which allows writing class documentation in HTML format.
To view the Documentation Browser click View > Windows > Documentation Browser.

Documentation Browser n
» - 5 L)
info rev hadr e
. ~
Modelica

Modelica Standard Library - Version 3.2.2

Information

Package Modelica® is a standardized and free package that is developed together with the Modelica® language from the Modelica
Association, see https://'www.Modelica.org. It is also caled Modelica Standard Library. It provides model components in many dormains
that are based on standardired interface definitions. Some typical examples are shown in the next figure:

l‘f‘?’ ambient
5, Did 00 I®
;{H : e

e I |

L]
AIMC1

cormvection

For an introduction, have especialy a look at:

* Overview provides an overview of the Modelica Standard Library inside the User's Guide.
¢ Release Motes summarizes the changes of new versions of this package.

¢ Contact lists the contributors of the Modelica Standard Library.

+ The Examples packages in the various libraries, demonstrate how to use the components of the corresponding sublibrary.

This version of the Modelica Standard Library consists of

« 1600 models and blocks, and
« 1350 functions

that are directly usable {= number of public, non-partial classes). It is fully compliant to Modelica Specification Version 3.2 Revision 2 and it
has heen tested with Madelica tanls fram different vendars.

Figure 3.3: Documentation Browser.
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3.2.4 Variables Browser

The class variables are structured in the form of the tree and are displayed in the Variables Browser. Each variable
has a checkbox. Ticking the checkbox will plot the variable values. There is a find box on the top for filtering the
variable in the tree. The filtering can be done using Regular Expression, Wildcard and Fixed String. The complete
Variables Browser can be collapsed and expanded using the Collapse All and Expand All buttons.

The browser allows manipulation of changeable parameters for Plot Window. It also displays the unit and descrip-
tion of the variable.

The browser also contains the slider and animation buttons. These controls are used for variable graphics and
schematic animation of models i.e., DynamicSelect annotation. They are also used for debugging of state ma-
chines. Open the Diagram Window for animation. It is only possible to animate one model at a time. This is
achieved by marking the result file active in the Variables Browser. The animation only read the values from the
active result file. It is possible to simulate several models. In that case, the user will see a list of result files in
the Variables Browser. The user can switch between different result files by right clicking on the result file and
selecting Set Active in the context menu.

Variables Browser g X

|FiItE|' Variables

|:| Casze Sensitive Regular Expression o
Expand All Collapse All

Simulation Time Unit g -

“ ’ II Time:| 0.0 Speed:| 1~
)

Variables Value Display Unit  Description
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[] derfv) 0.014557 km2...-1.g der(Voltage drop of...pins (= p.v - nv))
i 0.14557 A Current flowing from pin p to pin n
n

Yoltage drop of the... pins (= p.v - nw)
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= =] ra
(=9

=
=
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Figure 3.4: Variables Browser.
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3.2.5 Messages Browser

Shows the list of errors. Following kinds of error can occur,
* Syntax
e Grammar
e Translation
* Symbolic
¢ Simulation
e Scripting

See section Messages for Messages Browser options.

3.3 Perspectives

The perspective tabs are loacted at the bottom right of the MainWindow:
* Welcome Perspective
* Modeling Perspective
* Plotting Perspective

* Debugging Perspective

3.3.1 Welcome Perspective

The Welcome Perspective shows the list of recent files and the list of latest news from https://www.openmodelica.
org. See Figure 3.5. The orientation of recent files and latest news can be horizontal or vertical. User is allowed
to show/hide the latest news. See section General.

3.3.2 Modeling Perspective

The Modeling Perpective provides the interface where user can create and design their models. See Figure 3.6.

The Modeling Perspective interface can be viewed in two different modes, the tabbed view and subwindow view,
see section General.

3.3.3 Plotting Perspective

The Plotting Perspective shows the simulation results of the models. Plotting Perspective will automatically
become active when the simulation of the model is finished successfully. It will also become active when user
opens any of the OpenModelica’s supported result file. Similar to Modeling Perspective this perspective can also
be viewed in two different modes, the tabbed view and subwindow view, see section General.

3.3.4 Debugging Perspective

The application automatically switches to Debugging Perpective when user simulates the class with algorithmic
debugger. The prespective shows the list of stack frames, breakpoints and variables.
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3.4 File Menu

* New

* New Modelica Class - Creates a new Modelica class.

* New SSP Model - Creates a new SSP model.

* Open Model/Library File(s) - Opens the Modelica file or a library.

* Open/Convert Modelica File(s) With Encoding - Opens the Modelica file or a library with a specific encod-
ing. It is also possible to convert to UTF-8.

* Load Library - Loads a Modelica library. Allows the user to select the library path assuming that the path
contains a package.mo file.

* Load Encrypted Library - Loads an encrypted library. see OpenModelica Encryption

* Open Result File(s) - Opens a result file.

* Open Transformations File - Opens a transformational debugger file.

e New Composite Model - Creates a new composite model.

* Open Composite Model(s) - Loads an existing composite model.

* Load External Model(s) - Loads the external models that can be used within composite model.
* Open Directory - Loads the files of a directory recursively. The files are loaded as text files.

* Save - Saves the class.

* Save As - Save as the class.

* Save Total - Saves the class and all the classes it uses in a single file. The class and its dependencies can
only be loaded later by using the loadFile() API function in a script. Allows third parties to reproduce an
issue with a class without worrying about library dependencies.

e Import

e FMU - Imports the FMU.

e FMU Model Description - Imports the FMU model description.

* From OMNotbook - Imports the Modelica models from OMNotebook.

* Ngspice netlist - Imports the ngspice netlist to Modelica code.

» "Export"

* To Clipboard - Exports the current model to clipboard.

* Image - Exports the current model to image.

e FMU - Exports the current model to FMU.

* Read-only Package - Exports a zipped Modelica library with file extension .mol

* Encrypted Package - Exports an encrypted package. see OpenModelica Encryption
* XML - Exports the current model to a xml file.

* Figaro - Exports the current model to Figaro.

* To OMNotebook - Exports the current model to a OMNotebook file.

» System Libraries - Contains a list of system libraries.

* Manage Libraries

e Install Library - Opens a dialog to select and install a new library. see Install Library
* Upgrade Installed Libraries - Opens a dialog to upgrade the installed libraries.

» Update Library Index - Updates the library index.

* Recent Files - Contains a list of recent files.

e Clear Recent Files - Clears the list of recent files.
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e Print - Prints the current model.

* Quit - Quit the OpenModelica Connection Editor.

3.5 Edit Menu

* Undo - Undoes the last change.
* Redo - Redoes the last undone change.

e Filter Classes - Filters the classes in Libraries Browser. see Filter Classes

3.6 View Menu

* Toolbars - Toggle visibility of toolbars.

* Windows - Toggle visibility of windows.

* Close Window - Closes the current model window.

* Close All Windows - Closes all the model windows.

* Close All Windows But This - Closes all the model windows except the current.

* Cascade Windows - Arranges all the child windows in a cascade pattern.

¢ Tile Windows Horizontally - Arranges all child windows in a horizontally tiled pattern.
* Tile Windows Vertically - Arranges all child windows in a vertically tiled pattern.
* Toggle Tab/Sub-window View - Switches between tab and subwindow view.

* Grid Lines - Toggle grid lines of the current model.

* Reset Zoom - Resets the zoom of the current model.

e Zoom In - Zoom in the current model.

* Zoom Out - Zoom out the current model.

e Fit to Diagram - Fit the current model diagram in the view.

3.7 SSP Menu

* Add System - Adds the system to a model.

» Add/Edit Icon - Add/Edit the system/submodel icon.

* Delete Icon - Deletes the system/submodel icon.

* Add Connector - Adds a connector to a system/submodel.
Add Bus - Adds a bus to a system/submodel.

Add TLM Bus - Adds a TLM bus to a system/submodel.
Add SubModel - Adds a submodel to a system.
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3.8 Simulation Menu

* Check Model - Checks the current model.

* Check All Models - Checks all the models of a library.
* Instantiate Model - Instantiates the current model.

e Simulation Setup - Opens the simulation setup window.
* Simulate - Simulates the current model.

 Simulate with Transformational Debugger - Simulates the current model and opens the transformational
debugger.

* Simulate with Algorithmic Debugger - Simulates the current model and opens the algorithmic debugger.
* Simulate with Animation - Simulates the current model and open the animation.

* Archived Simulations - Shows the list of simulations already finished or running. Double clicking on any of
them opens the simulation output window.

3.9 Data Reconciliation

* Calculate Data Reconciliation - Opens the dialog to run the data reconciliation algorithm.

3.10 Sensitivity Optimization Menu

* Run Sensitivity Analysis and Optimization - Runs the sensitivity analysis and optimization.

3.11 Debug Menu

* Debug Configurations - Opens the debug configurations window.

e Attach to Running Process - Attaches the algorithmic debugger to a running process.

3.12 Tools Menu

* OpenModelica Compiler CLI - Opens the OpenModelica Compiler command line interface window.

* OpenModelica Command Prompt - Opens the OpenModelica Command Prompt (Only available on Win-
dows).

* Open Temporary Directory - Opens the current temporary directory.
* Open Working Directory - Opens the current working directory.
* Open Terminal - Runs the terminal command set in General.

* Options - Opens the options window.
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3.13 Help Menu

* OpenModelica User's Guide - Opens the OpenModelica User's Guide.

* OpenModelica User's Guide (PDF) - Opens the OpenModelica User's Guide (PDF).

* OpenModelica System Documentation - Opens the OpenModelica System Documentation.

* OpenModelica Scripting Documentation - Opens the OpenModelica Scripting Documentation.
* Modelica Documentation - Opens the Modelica Documentation.

* OMSimulator User's Guide - Opens the OMSimulator User's Guide.

* OpenModelica TLM Simulator Documentation - Opens the OpenModelica TLM Simulator Documentation.

About OMEdit - Shows the information about OpenModelica Connection Editor.

3.14 Modeling a Model

3.14.1 Creating a New Modelica Class

Creating a new Modelica class in OMEdit is rather straightforward. Choose any of the following methods,
* Select File > New > New Modelica Class from the menu.
* Click on New Modelica Class toolbar button.
* Click on the Create New Modelica Class button available at the left bottom of Welcome Perspective.

e Press Ctrl+N.

3.14.2 Opening a Modelica File

Choose any of the following methods to open a Modelica file,
* Select File > Open Model/Library File(s) from the menu.
* Click on Open Model/Library File(s) toolbar button.
* Click on the Open Model/Library File(s) button available at the right bottom of Welcome Perspective.
* Press Ctrl+O.
(Note, for editing Modelica system files like MSL (not recommended), see Editing Modelica Standard Library)

3.14.3 Opening a Modelica File with Encoding

Select File > Open/Convert Modelica File(s) With Encoding from the menu. It is also possible to convert files to
UTF-8.

3.14.4 Model Widget

For each Modelica class one Model Widget is created. It has a statusbar and a view area. The statusbar contains
buttons for navigation between the views and labels for information. The view area is used to display the icon,
diagram and text layers of Modelica class. See Figure 3.9.
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3.14.5 Adding Component Models

Drag the models from the Libraries Browser and drop them on either Diagram or Icon View of Model Widget.

3.14.6 Making Connections

In order to connect one component model to another the user first needs to enable the connect mode (<:) from
the toolbar.

Move the mouse over the connector. The mouse cursor will change from arrow cursor to cross cursor. To start
the connection press left button and move while keeping the button pressed. Now release the left button. Move
towards the end connector and click when cursor changes to cross cursor.

3.15 Simulating a Model

The simulation process in OMEdit is split into three main phases:

1. The Modelica model is translated into C/C++ code. The model is first instantiated by the frontend, which
turns it into a flat set of variables, parameters, equations, algorithms, and functions. The backend then
analyzes the mathematical structure of the flat model, applies symbolic simplifications and determines how
the equations can be solved efficiently. Finally, based on this information, model-specific C/C++ code is
generated. This part of the process can be influenced by setting Translation Flags (a.k.a. Command Line
Options), e.g. deciding which kind of structural simplifications should be performed during the translation
phase.

2. The C/C++ code is compiled and linked into an executable simulation code. Additional C/C++ compiler
flags can be given to influence this part of the process, e.g. by setting compiler optimizations such as —03.
Since multiple C/C++ source code files are generated for a given model, they are compiled in parallel by
OMEdit, exploiting the power of multi-core CPUs.

3. The simulation executable is started and produces the simulation results in a .mat or .csv file. The runtime
behaviour can be influenced by Simulation Flags, e.g. by choosing specific solvers, or changing the output
file name. Note that it it possible to re-simulate a model multiple times, changing parameter values from the
Variables Browser and/or changing some Simulation Flags. In this case, only Phase 3. is repeated, skipping
Phases 1. and 2., which enables much faster iterations.

The simulation options for each model are stored inside the OMEdit data structure. They are set according to the
following sequence,

* Each model has its own translation and simulation options.

* If the model is opened for the first time then the translation and simulation options are set to defaults, that
can be customized in Tools | Options | Simulation.

* experiment,__ OpenModelica_commandLineOptionsand__ OpenModelica_simulationFlags
annotations are applied if the model contains them.

e After that all the changes done via Simulation Setup window for a certain model are pre-
served for the whole session. If you want to use the same settings in future sessions then
you should store them inside experiment, OpenModelica_commandLineOptions, and
__OpenModelica_simulationFlags annotations.

The OMEdit Simulation Setup can be launched by,
* Selecting Simulation > Simulation Setup from the menu. (requires a model to be active in ModelWidget)
¢ Clicking on the Simulation Setup toolbar button. (requires a model to be active in ModelWidget)

 Right clicking the model from the Libraries Browser and choosing Simulation Setup.
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3.15.1 General

* Simulation Interval
e Start Time — the simulation start time.
* Stop Time — the simulation stop time.
e Number of Intervals — the simulation number of intervals.
e Interval — the length of one interval (i.e., stepsize)
¢ Integration
* Method — the simulation solver. See section Integration Methods for solver details.
» Tolerance — the simulation tolerance.
e Jacobian - the jacobian method to use.
* DASSL/IDA Options
* Root Finding - Activates the internal root finding procedure of dassl.
* Restart After Event - Activates the restart of dassl after an event is performed.
e [nitial Step Size
* Maximum Step Size
* Maximum Integration Order
e C/C++ Compiler Flags (Optional) — the optional C/C++ compiler flags.
* Number of Processors — the number of processors used to build the simulation.
* Build Only — only builds the class.
* Launch Transformational Debugger — launches the transformational debugger.
e Launch Algorithmic Debugger — launches the algorithmic debugger.

e Launch Animation — launches the 3d animation window.

3.15.2 Interactive Simulation

» Simulate with steps (makes the interactive simulation synchronous; plots nicer curves at the expense of
performance)

» Simulation server port

3.15.3 Translation Flags

3.15.4 Simulation Flags

* Model Setup File (Optional) — specifies a new setup XML file to the generated simulation code.

* [Initialization Method (Optional) — specifies the initialization method.

* Equation System Initialization File (Optional) — specifies an external file for the initialization of the model.
» Equation System Initialization Time (Optional) — specifies a time for the initialization of the model.

* Clock (Optional) — the type of clock to use.

* Linear Solver (Optional) — specifies the linear solver method.

* Non Linear Solver (Optional) — specifies the nonlinear solver.

* Linearization Time (Optional) — specifies a time where the linearization of the model should be performed.

* Qutput Variables (Optional) — outputs the variables a, b and c at the end of the simulation to the standard
output.
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* Profiling — creates a profiling HTML file.

e CPU Time — dumps the cpu-time into the result file.

* Enable All Warnings — outputs all warnings.

* Logging (Optional)

e stdout - standard output stream. This stream is always active, can be disabled with -lv=-stdout
* assert - This stream is always active, can be disabled with -lv=-assert

e LOG_DASSL - additional information about dassl solver.

* LOG_DASSL_STATES - outputs the states at every dassl call.

* LOG_DEBUG - additional debug information.

e LOG_DSS - outputs information about dynamic state selection.

e LOG_DSS_JAC - outputs jacobian of the dynamic state selection.

* LOG_DT - additional information about dynamic tearing.

e LOG_DT_CONS - additional information about dynamic tearing (local and global constraints).
* LOG_EVENTS - additional information during event iteration.

e LOG_EVENTS_V - verbose logging of event system.

e LOG_INIT - additional information during initialization.

e LOG_IPOPT - information from Ipopt.

e LOG_IPOPT_FULL - more information from Ipopt.

* LOG_IPOPT _JAC - check jacobian matrix with Ipopt.

e LOG_IPOPT_HESSE - check hessian matrix with Ipopt.

e LOG_IPOPT_ERROR - print max error in the optimization.

e LOG_JAC - outputs the jacobian matrix used by dassl.

* LOG_LS - logging for linear systems.

e LOG_LS_V - verbose logging of linear systems.

* LOG_NLS - logging for nonlinear systems.

* LOG_NLS_V - verbose logging of nonlinear systems.

* LOG_NLS_HOMOTOPY - logging of homotopy solver for nonlinear systems.
e LOG_NLS_JAC - outputs the jacobian of nonlinear systems.

* LOG_NLS_JAC_TEST - tests the analytical jacobian of nonlinear systems.

* LOG_NLS_RES - outputs every evaluation of the residual function.

e LOG_NLS_EXTRAPOLATE - outputs debug information about extrapolate process.
* LOG_RES_INIT - outputs residuals of the initialization.

* LOG_RT - additional information regarding real-time processes.

e LOG_SIMULATION - additional information about simulation process.

e LOG_SOLVER - additional information about solver process.

e LOG_SOLVER_V - verbose information about the integration process.

* LOG_SOLVER_CONTEXT - context information during the solver process.

e LOG _SOTI - final solution of the initialization.

* LOG_STATS - additional statistics about timer/events/solver.

e LOG_STATS_V - additional statistics for LOG_STATS.

e LOG_SUCCESS - This stream is always active, can be disabled with -lv=-LOG_SUC